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Installation Overview Components

Installation Overview

CA Identity Portal is a web-based business-ready identity and access management application. CA
Identity Portal provides a business logic layer that leverages and aggregates functionality from existing
Identity Management products, such as CA Identity Manager (CA IDM) and CA Identity Governance
(CA GM). CA Identity Portal is designed for the non-technical business end user and delivers an
intuitive all-inclusive interface in the form of a single page web application.

From a components perspective, CA ldentity Portal is a java web application that is deployed on a
supported application server or servlet container. CA Identity Portal requires a database for its
configuration and persistence stores. CA Identity Portal interfaces with the organization's existing IDM
platforms (such as CA ldentity Manager) through CA Identity Portal backend connectors. CA Identity
Portal communicates with the IDM backend platforms using the exposed public APIs of these backend
systems (for example, Web Services (TEWS) & Workpoint APIs for CA IDM, and web services API for CA
GM).

CA Identity Portal can be deployed in a single node configuration or in a multi node cluster
configuration. A CA Identity Portal cluster configuration does not depend on the application server
cluster abilities and can exist even if the application server itself is not deployed in a cluster mode.

CA Identity Portal can be deployed with basic authentication, where user credentials (user id,
password) are validated to a main CA Identity Portal backend connector (for example CA IDM).
Alternatively, CA Identity Portal can be integrated with Single Sign On to deliver an SSO experience to
the end user.

Components

4.8

End User Browser

CA Single Sign On
Web Agent

1

CA Identity Manager % (—— >

Load Balancer

CA Identity Portal CA ldentity Portal Database

CA Identity Governance
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Software Requirements

This section describes the supported software prerequisites for installing CA Identity Portal.

Operating Systems

(0} Version Notes
Microsoft Windows Server 2008 R2 (SP1,5P2) 64 bit
Red Hat Enterprise Linux 6.x 64 bit

Application Servers

The following are supported application servers on which CA Identity Portal can be deployed. These
servers are supported on all the Operating Systems described above.

Application Server Version Java Version Notes

Apache Tomcat $7.0.50 SunJDK1.6x  Ona Windows OS,
update 40 and install Apache Tomcat
above using the Apache

Tomcat automatic
installer (apache-
tomcat-7.0.50.exe),
which also registers
Apache Tomcat as a
Windows Service (Do
not use the ZIP
distribution).

Oracle WebLlogic 11g R1(10.3.5,10.3.6), SunJDK 1.6.x Only Native Oracle
12¢(12.1.1 Only) update 40 and Weblogic Cluster
above. configuration is

supported (Single
node cluster or more).

Red Hat (RH) JBoss EAP 6.1.0 GA Sun JDK 1.6.x Only Standalone
(Application Server 7.2) update 40 and server is supported
above. ((RH) JBoss Native
Cluster is not
supported)

@ Note: General notes for supported application servers:
- Only 64 bit application servers are supported.
- Only 64bit Java JDKs are supported. JREs are not supported (CA Identity Portal includes runtime
compile elements).
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Databases

CA Identity Portal supports the following databases used for its runtime and persistent stores.

Vendor Version Notes

Oracle 11g R2 RAC is supported.
MysQL 5.5.x

MS sQL 2008 R2 XA Transactions must be

configured on the Database
(see Appendix A for more
information)

CA Identity Manader and CA Identity Governance Back-ends

Vendor Version Notes
CA Identity Manager 12.5 (SP6-SP15), 12.6 Supported IDM Application
(SP1,5P2,5P3,5P4) servers: (RH) JBoss, Oracle
WebLogic, WebSphere
CA Identity Governance 12.5 (SP6 and above)
12.6 (SPO, SP1)

@ Note: In case CA Identity Manager or CA Identity Governance are deployed in a cluster, a NLB (Network
Load Balancer) VIP is required for CA Identity Portal to leverage all IDM/GM cluster nodes.

CA Single Sign On Option
Vendor Version Notes
CA Single Sign On ri2.5 If CA Identity Portal is
r6.0 SP6 CR9 integrated with CA Single

Sign On, IDM TEWS must
r12.0 SP3 CR11 and above also be integrated with CA

Single Sign On.
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Web Clients (Browsers)

Browser Version Notes

Internet Explorer ~ 89,10,11,12  On Windows Desktop 0S |
Mozilla Firefox 3.6 and above On Windows Desktop OS
Google Chrome All versions On Windows Desktop OS
Safari 6.1 and above On Mac OS

[z] Note: The recommended screen resolution is 1280x800 (pixels)

Hardware Requirements

The following are recommended PRODUCTION hardware specifications for the CA Identity Portal
application server nodes. For fault tolerance and performance considerations, CA Identity Portal needs
to be deployed in at least a two node cluster (two distinct servers).

Component (per node) Minimum Recommended

CPU Dual Core Intel (or . Quad Core Intel (or
compatible) 2.0 GHz Xeon or  compatible) 2.0 GHz Xeon or
similar (64 bit) similar (64 bit)

RAM 16 GB 32GB

Local Storage 160 GB 160 GB

Database Storage 1GB Initial Size 5 GB Initial Size

Shared Storage (for 50 GB 100 GB

uploaded files)

Network Requirements

The following table summarizes the Firewall/Communications requirements between CA Identity
Portal and various solution components.

From To Port and Protocol [\ [} {=H ‘
Web Servers CA Identity Portal CA Identity Portal For example: 8080 for
(SSO web agents) application servers Application Server Apache Tomcat

HTTP port
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CA Identity Portal
Application Servers

CA Identity Portal
Application Servers

CA Identity Portal
Application Servers

CA Identity Portal
Database

CA Identity Manager
Servers

CA Identity
Governance Servers

DNS Requirements

Database port
ALL TCP Ports HTTP and RMI Traffic

TCP/8080 (HTTP)

CA Identity Portal
Application Servers

CA Identity Portal
Application Server
HTTP port

Identity Manager Servers

E] Note: If CA Identity Manager or CA ldentity Governance are deployed in a cluster an NLB (Network Load
Balancer) VIP is required for CA Identity Portal to leverage all IDM/GM cluster nodes. CA Identity Portal
will be configured to point to the VIP (Virtual IP) representing the CA IDM, CA GM clusters. NLB VIP
Characteristics are as follows:

= Relay: All TCP ports.

m  Load Balancing Scheme: Round Robin (No IP-stickiness).

= Health Monitor: Basic HTTP on the IDM/GM application server HTTP port (for example
8080 on (RH) JBoss).

DNS Requirements

The CA Identity Manager application servers FQDNs should be resolvable from all the CA Identity
Portal Application server nodes. Resolution should be performed either via DNS or a local host’s file
override.

Cluster Requirements

When CA Identity Portal is deployed in a cluster, CA Identity Portal nodes use Java Groups technology
to communicate and replicate configuration and state. CA Identity Portal does this in order to enhance
performance and simplify the process of committing/announcing a configuration change to all the
nodes in the CA Identity Portal cluster.

This is not a mandatory requirement (although it is a recommended best practice). In case the
requirement is not addressed in a given CA Identity Portal cluster deployment, please see the note at
the end of this section for guidelines regarding running CA Identity Portal in such an environment.

Java Groups discovery relies on UDP Multicast. For UDP Multicast to be possible, the CA Identity Portal
cluster nodes should reside on the same network switch. In case the CA Identity Portal nodes reside
on different network switches, layer 2 Multicast spoofing must be enabled on these switches.
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Choosing a Multicast Address
By default, the CA Identity Portal installer uses the following multicast address:
228.6.7.9

You need to make sure this address is not currently being used. Use the testing procedure described in
the next section to check this.

However, in case you are installing several CA Identity Portal environments on the same physical
network (for example a Development and a QA environment), you should use a different multicast
address for each installation/CA Identity Portal cluster.

For example:

The CA Identity Portal Development environment nodes will use the multicast address: 228.6.7.9
The CA Identity Portal QA environment nodes will use the multicast address: 228.6.7.10
Otherwise, you run the risk of CA Identity Portal nodes from the QA environment, joining the CA
Identity Portal Development cluster and vice versa.

Testing JGroups Multicast

1. Download the following "jgroups-3.3.1.Final.jar"JAR file from the JGroups web site.

http://sourceforge.net/projects/javagroups/files/IGroups/3.3.1.Final/

2. Copy the "jgroups-3.3.1.Final.jar" file to each of the CA Identity Portal application servers to a
folder of your choice.

3. Openacommand prompt to that folder.

4. Run the jgroups Receiver Test on the 1°* node (Java Runtime needs to be installed):

java -cp jgroups-3.3.1.Final.jar org.jgroups.tests.McastReceiverTest -mcast addr
228.6.7.9 -port 46656

5. Run the jgroups Sender Test on the 2" node:

java -cp jgroups-3.3.1.Final.jar org.jgroups.tests.McastSenderTest -mcast addr
228.6.7.9 -port 46656

6. Type something in the sender console and press enter.
The message should display in the receiver console on the other node.

7. Switch receiver and sender sides and try again to validate both directions work.

What to Do If Multicast Is Not Available

When the CA Identity Portal cluster requirements, detailed in the section above, cannot be met, the
following should be taken into consideration:

1. After performing configuration changes via the CA Identity Portal Admin Ul, you must then
connect to the CA Identity Portal Admin Ul on each node in the cluster and flush (Clear) all the
CA Identity Portal caches (using the Tools/Cache section in the Admin Ul).


http://sourceforge.net/projects/javagroups/files/JGroups/3.3.1.Final/jgroups-3.3.1.Final.jar/download
http://sourceforge.net/projects/javagroups/files/JGroups/3.3.1.Final/

Installation Overview Cluster Requirements

2. Cache based optimization in CA Identity Portal will be available on a per node basis. For
example, if a certain user search has been performed on a specific node in the cluster, the
result set will be cached only on the node (and not replicated to the other cluster nodes).

@ Note: In some cases, IPv6 addresses might interfere with Java Groups operations. If you experience
issues with the CA Identity Portal cluster, add the following parameter to the server startup for each CA
Identity Portal node:

Djava.net.preferlPv4Stack=true
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Installing CA Identity Portal on an
Application Server

Installation Overview

1) Install and prepare a Database

2) Install a JDK

3) Install and prepare the Application Server

4) Add 3 Part Jars to the Application Server

5) Install CA Identity Portal (using the Installer or using a Manual procedure)

6) Perform Post Installation Steps

Installation Prerequisites

1 - Install and Prepare a Database

Oracle Database

a) Install a supported version of the Oracle database. It is recommended that the database will
run on a separate server than the CA Identity Portal application server.

b) Create a dedicated schema for CA Identity Portal. The schema user should have the following

DB Roles:
o CONNECT
e RESOURCE

c) Record the database user and password to be supplied to the CA Identity Portal installer.

@ Note: The database should be configured to support XA transactions. Consult your Database
documentation on how to configure this.

MySQL Database
a) Install a supported version of the MySQL database.

b) Itis recommended that the database will run on a separate server than the CA Identity Portal
application server.

c) Create a dedicated database instance for CA Identity Portal. Create a user with all privileges on
the CA Identity Portal schema and grant remote access to this user.
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d) Record the database user and password to be supplied to the CA Identity Portal installer.

MS SQL Database

a) Install a supported version of the MS SQL database (It is recommended that the database will
run on a separate server than the CA Identity Portal application server).

b) MS SQL Server Security should be set to: "SQL Server and Windows Authentication mode".
c) Create a dedicated database instance for CA Identity Portal.

d) Create a Login User (SQL Server authentication) with DBO privilege on the CA Identity Portal
Database schema (record the user name and password).

e) Configure TCP/IP connectivity for the SQL Server (record the TCP port to which the server is
bound).

f) Enable XA Transactions for the MS SQL Server (see "Appendix A" for more information).

2 - Install a JDK

Install a supported Java Development Kit (JDK).

@ Note: If installing on Linux, make sure the JDK bin folder is the user's environment path. To verify this,
type "java —version" on the command prompt and make sure the JDK runtime is indeed invoked.

3 - Install and Prepare the Application Server

(RH) JBoss Application Server
a) Install a supported application server.

b) Make sure the application server is configured to run with the JDK you installed (not the JRE).
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One way to make sure (RH) JBoss starts with a JDK is to set a system wide environment variable:
JAVA_HOME and point it to the JDK home.
For example (on Windows):

Environment Yariables

—User velgi\al:ules For Adminiskrakor

Yariabli | Walue |
TEMP %= JSERPROFILE®: 1 AppDatal Locall Temp
TP % JSERPRIOFILE%: AppDatal Locall Temp

Mew. .. Edit. .. | Delete |

— Syskem variables

Yariable | Walue | -

ComSpe: Chwindowsisystern32iomd. exe |-

FP_MO_HOST ... MO

J1avA_HOME C:Y\Program Files)Javaijdkl.6.0_45

MUMBER_OF P... 2 |
Mt | Edit. .. | Delete |

K I Zancel |

Alternatively, you can modify the JBoss standalone.bat/.sh script and declare the JAVA_HOME
variable at the beginning of the file:

For example (on Windows):
set JAVA_HOME=c:\Java\jdk1.6.0_45
or on Linux:
export JAVA_HOME=c:\Java\jdk1.6.0_45

c) Verify the application server starts correctly (using the standalone server start script).
By default, (RH) JBoss only binds to the loopback interface (127.0.0.1). To bind (RH) JBoss to all
interfaces (so it can be accessed from outside the hosting server) invoke the standalone
startup scrip with the following parameters:

—b=0.0.0.0
—bmanagement=0.0.0.0

For example:
Standalone.bat -b=0.0.0.0 -bmanagement=0.0.0.0
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d) Verify (RH) JBoss started with the JDK. (RH) JBoss log should show a line pointing to your JDK.
For example:

java.home = c:\Program Files\Java\jdk1.6.0_45\jre

e) Record the application server base directory to be supplied to the CA Identity Portal installer.

@ Note: The CA Identity Portal installer supports installation on (RH) JBoss in "Standalone" server mode. To
achieve a CA Identity Portal cluster configuration, you will need to run the CA Identity Portal installer on
separate (RH) JBoss deployments in "Standalone" mode.

Oracle WebLogic Application Server
a) Install a supported application server.

b) Make sure the application server is configured to run with the JDK you installed (not the JRE).

@ Note: The CA Identity Portal installer requires Oracle WebLogic to be configured in a cluster
configuration with at least one admin server and one managed server. In addition Oracle WebLogic Node
Manager must be configured and used to start and stop the managed server/s on which CA Identity
Portal is to be installed.

c) Verify the application server starts correctly when started using Oracle WebLogic Node
Manager (by starting the managed server from the Oracle WebLogic Administration Console).

d) Record the application server base directory to be supplied to the CA Identity Portal installer.

Apache Tomcat Server

a) Install a supported application server.

@ Note: On a Windows OS, install Apache Tomcat using the Apache Tomcat automatic installer (apache-
tomcat-7.0.50.exe), which also registers Apache Tomcat as a Windows Service (Do not use the ZIP
distribution).

b) Make sure the application server is configured to run with the JDK you installed (not the JRE).

Example: When installing Apache Tomcat, during the installation process you are required to
supply the path to a Java SE 6.0 JRE. At this point you should point the installer to the Java JDK
home directory rather than to the JRE home directory.
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Apache Tomcat Setup: Java Yirtual Machine path selection

Java Yirtual Machine " .
Java Virtual Machine path selection, :

Please select the path of a Java SE 6.0 or later JRE installed on wour swstem,

I C:AProgram Fileshlavaljdkl . 6.0_41 D

c) Verify the application server starts correctly.

d) Record the application server base directory to be supplied to the CA Identity Portal installer.

4 - Add 3rd Party Jars to the Application Server

Download the Database JDBC Driver for Your Database

You need to download a JDBC driver specific to your database vendor and place this driver in the
application server lib folder. Follow the instructions below to accomplish this for your database and
application server types.

MySQL Database (version 5.1x)

CA Identity Portal requires driver version 5.1.x and above (for example: mysql-connector-java-5.1.25-
bin).

Download this driver from the following web site:

http://dev.mysqgl.com/downloads/connector/j/

Oracle Database
CA Identity Portal requires the latest Oracle JDBC driver for Java Runtime v.6 (ojdbcé6.jar).

Download this driver distribution from the Oracle web site.

MS SQL Database (version 4)
CA Identity Portal requires MS SQL JDBC Driver v4.
Download this driver distribution from the Microsoft web site:

http://www.microsoft.com/en-us/download/details.aspx?displaylang=en&id=11774



http://dev.mysql.com/downloads/connector/j/
http://www.microsoft.com/en-us/download/details.aspx?displaylang=en&id=11774
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Apache Tomcat Server 3" Party Jars Installation

Installing Database JDBC Driver on Apache Tomcat

a) Locate the JDBC driver jar in the JDBC driver distribution you downloaded, and place this jar in
the Apache Tomcat "lib" folder.

For example: C:\Tomcat 7.0\lib

b) Restart the Apache Tomcat application server.

Installing BITRONIX (JTA) on Apache Tomcat

Apache Tomcat application server does not supply JTA transaction Manager functionality that is
required by CA Identity Portal. When using Apache Tomcat, you need to download and install Bitronix,
which is an open-source JTA transaction Manager. CA Identity Portal supports the Bitronix Transaction
Manager (BTM) version 2.1.3.

a) Download the BTM distribution from the following web site:

http://bitronix.be/downloads/btm-dist-2.1.3.zip

or

Browse to the Bitronix web site (http://bitronix.be/) and search for the 2.1.3 distribution
version in the Download Archives section.

b) Unzip the BTM distribution and copy to following jars to your Apache Tomcat lib folder
i. <BTM Distro Root>\lib\slf4j-api-1.6.4.jar
ii. <BTM Distro Root>\lib\sIf4j-jdk14-1.6.4.jar
iii. <BTM Distro Root>\lib\geronimo-jta_1.1_spec-1.1.1.jar
iv. <BTM Distro Root>\integration\btm-tomcat55-lifecycle-2.1.3.jar
v. <BTM Distro Root>\btm-2.1.3.jar

Example Tomcat destination directory: C:\Tomcat 7.0\lib
JBoss Application Server 3 Party Jars Installation

Installing Database JDBC Driver on (RH) JBoss

For (RH) JBoss, CA Identity Portal requires that the database JDBC driver be deployed as a (RH) JBoss
Module.

Deployment of the JDBC Driver as a module differs slightly between database vendors.

Follow the steps below to deploy the JDBC driver for your database vendor type

@ For more information, consult the JBoss Application Server documentation on how to deploy a JDBC
driver on JBoss:
https://community.jboss.org/wiki/DataSourceConfigurationInAS7#jive content id Installing a JDBC driver
as_a_module



http://bitronix.be/downloads/btm-dist-2.1.3.zip
http://bitronix.be/
https://community.jboss.org/wiki/DataSourceConfigurationInAS7#jive_content_id_Installing_a_JDBC_driver_as_a_module
https://community.jboss.org/wiki/DataSourceConfigurationInAS7#jive_content_id_Installing_a_JDBC_driver_as_a_module
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@ In case you want to use a MSSQL database with JBoss, you need to configure both MySQL and MSSQL
JDBC drivers on JBoss (Follow the instructions in this section for both MySQL and MSSQL JDBC drivers).

Oracle JDBC Driver
a) Create the following directory tree inside the “<jboss-home>/modules” directory:
oracle/jdbc/main/

For example:

cd C:\jboss-eap-6.1\modules mkdir oracle\jdbc\main)\

b) Copy your JDBC driver jar (For Oracle this is: “ojdbc6.jar”) to the “<jboss-
home>/modules/oracle/jdbc/main” directory.
c) Using a text editor, create a file called “module.xm

home>/modules/oracle/jdbc/main” as following:

IH

inside “<jboss-

<?xml version="1.0" encoding="UTF-8"?>
<module xmlns="urn:jboss:module:1.0" name="oracle.jdbc">
<resources>
<resource-root path="ojdbc6.jar"/>
</resources>
<dependencies>
<module name="javax.api"/>
<module name="javax.transaction.api"/>
</dependencies>

</module>

d) Now open your <jboss-home>/standalone/configuration/standalone.xml file and add the
driver declaration tag referring to the new module as following (look for the default driver
declaration tag already contained in the file <driver name="h2?
module="com.h2database.h2?> and add your driver declaration before it):

<driver name="oracle" module="oracle.jdbc">
<driver-class>oracle.jdbc.OracleDriver</driver-class>

<xa-datasource-class>oracle.jdbc.xa.client.OracleXADataSource</xa-datasource-
class>

</driver>

e) Restart the application server.
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MYSQL JDBC Driver
1) Create the following directory tree inside the “<jboss-home>/modules” directory:

com/mysql/main/
For example:

cd C:\jboss-eap-6.1\modules
mkdir com\mysqgl\main)\

2) Copy your JDBC driver jar (For MSSQL this is: “mysql-connector-java-5.1.25.jar”) to the “<jboss-
home>/modules/com/mysgl/main” directory.

3) Using a text editor, create a file called “module.xml” inside “<jboss-
home>/modules/com/mysgl/main” as following:
<module xmlns="urn:jboss:module:1.0" name="com.mysql">
<resources>
<resource-root path="mysgl-connector-java-5.1.25.jar"/>
</resources>
<dependencies>
<module name="javax.api"/>
<module name="javax.transaction.api"/>
</dependencies>
</module>
4) Now open your ““<jboss-home>/standalone/configuration/standalone.xml” file and add the driver
declaration tag referring to the new module as following (look for the default driver declaration
tag already contained in the file <driver name="h2? module="com.h2database.h2?> and add your
driver declaration before it):
<driver name="mysqgl" module="com.mysgl">
<driver-class>com.mysql.jdbc.Driver</driver-class>

<xa-datasource-class>com.mysqgl.jdbc.jdbc2.optional .MysglXADataSource</xa-
datasource-class>

</driver>

5. Restart the application server.
Oracle WebLogic Server 3 Party Jars Installation

Installing database JDBC driver on Oracle WebLogic Server
Oracle WebLogic comes with pre-loaded JDBC drivers for Oracle, MySQL and MS SQL databases.

There is no need to load 3™ party drivers to Oracle WebLogic.
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5 - (JBoss only) Disable application server modules

For JBoss only, you need to disable the native JBoss "WELD" module.

1. Make a backup of the JBoss standalone.xml configuration file (for example: <jboss-
home>\standalone\configuration\standalone.xml)
2. Open the standalone.xml for editing, look for and delete the following sections:
a. <extension module="org.jboss.as.weld"/>
b. <subsystem xmlIns="urn:jboss:domain:weld:1.0"/>
3. Save the file.

Installing Using the CA Identity Portal Installer

Use the following procedure to install CA Identity Portal on Windows or Linux.

E] Note: If installing on Linux, ensure that you run the CA Identity Portal installer using the same user that

was used to install the Application Server, and that the JDK bin folder is in the user's environment path. To
verify type "java —version" on the command prompt and make sure the JDK runtime is indeed invoked.

8:

Verify the installation pre-requisites described in the previous chapter have been met.

For Apache Tomcat, stop the application server on which you intend to deploy CA Identity Portal
(for Oracle WebLogic, (RH) JBoss keep the application server started and make sure you can access
the application server admin console).

Run the CA Identity Portal installer (sigma.exe/sigma.bin) on the computer where the CA Identity
Portal application server is installed.

Choose the installation mode: "Extract Only" or "Install All". For a Wizard based installation,
choose "Install All". For a manual installation, choose "Extract Only" and skip to the next chapter
in this guide.

Accept the license agreement.

Supply the path to the installed JDK home folder.
For example: C:\Program Files\Java\jdk1.6.0_41

Select the Application Server type (Apache Tomcat, Oracle WebLogic, (RH) JBoss) to which CA
Identity Portal will be deployed.

In case of Apache Tomcat, enter the Apache Tomcat Windows Service name (as viewed in the
windows services mmc snap-in). For example: Tomcat7.

Choose and enter a UserlID and Password to be used as the CA Identity Portal Administrator.

@ Note: This username and password pair will be created in the Application Server security realm. In case of

(RH) JBoss, make sure you choose a complex password (at least nine characters long, including a capital
letter, number and a non-alphanumeric character. For example: Pizass1!).

9:

Choose a folder location for the CA Identity Portal client log files.
For example: C:\SIGMA\Logs
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@ Note: This folder will be created, in case it does not exist.

10: Select a database type to be used for the CA Identity Portal configuration and runtime store
(MysQL, MS ssQL, Oracle).

E] Note: In the case of JBOSS, the installer currently only supports MySQL and Oracle databases. If you need
to use MSSQL with JBoss, please select "MySQL" as the database type (After the installer completes the
installation, follow the instructions in Appendix C to configure JBoss for a MSSQL database). If not done
already, before you continue with the installation, you should also prepare the MySQL JDBC driver on the
JBoss server (even if you are not planning to use it). See 4 — Add 3rd Party Jars to the Application Server in
the Installation Prerequisites section.

11: Supply database connection and credential information.

Note: The installer does not verify connectivity and credentials to the database. Please make sure
the connection details and credentials are valid.

12: Choose to install the included CA Identity Portal release version or install a patched CA Identity
Portal version.

13: Choose a CA Identity Portal home folder (where the tools and sample files will be installed).

@ Note: This folder will be created, in case it does not exist.

14: Review and approve the summary of installation. Click "Install" to perform the actual installation.
15: Validate installation results:
a. If the application server has not been started by the installer, start the application server now.
b. Review application server log file for startup errors.
c. Check that the CA Identity Portal Administration Ul is up.

i. Browse to: http://<application server host>:port/sigma/admin
For example: http://localhost:8080/sigma/admin

ii. Provide the CA Identity Portal Administrator Username and Password you set during the
installation.

Proceed to the "Post Installation" section in this document.

@ Note: For a CA Identity Portal Apache Tomcat or (RH) JBoss cluster installation, rerun this installation
procedure on each CA Identity Portal application server node. In case of Oracle WebLogic, the Oracle
WebLogic cluster takes care of deploying CA Identity Portal to the managed cluster nodes.
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Manual Installation

Overview

To install CA Identity Portal manually, you must first have all the pre-requisites in place. See and
review the pre-requisites section in this document for more information.

Once the pre-requisites are fulfilled, you will need to perform the following steps to install CA Identity
Portal manually on the application server:

1. Extract the CA Identity Portal application and sample configuration files from the installer.
2. Generate a CA Identity Portal keystore file.

3. Set CA Identity Portal specific JVM options in the application server.

4. Configure a database data source in the application server.

5. Configure Bitronix Transaction Manager (for Apache Tomcat Only).

6. Deploy the CA Identity Portal Web Archive to the Application Server.

7. Create a user to access the CA Identity Portal Admin UL.

8. Verify the installation.

Extract the CA Identity Portal Application and Sample Configuration Files

Run the CA Identity Portal installer in "Extract Only" mode. This will extract required files and samples
to a location of your choice in the file system (This location will be referenced as the CA Identity Portal
Home Folder).

Preferably, run the installer on the application server host machine (otherwise, you will need to copy
sample configuration files from the extracted installer to the application server).

Generate a CA Identity Portal Keystore File

CA Identity Portal requires a key to encrypt sensitive configuration data in the database. This key is
stored in a CA Identity Portal specific Java Keystore file.

Use the following procedure to create a key and Keystore file for CA Identity Portal. In the next step
you will configure JVM parameters that point to the Keystore file you created.

1. Openacommand prompt and change directories to the CA Identity Portal "sigma-keystore-
tool" folder located in the CA Identity Portal home folder (where you extracted the CA Identity
Portal installer in the previous step).

For example:

<SIGMA_HOME>\SIGMA\sigma-keystore-tool\
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2. Run the following command to generate the CA Identity Portal Keystore:

java -jar CreateSigmaKeystore.jar <keystore file path> <keystore password> <key name>
<key password>

For example:
java -jar CreateSigmaKeystore.jar mysigmaks.ks kssecret sigmakey keysecret
3. Record the full path to the keystore you created and all the other parameters you provided. In

the next section you will create CA Identity Portal specific JVM options that point the keystore
and its parameters.

@ Note: In case you plan to install CA Identity Portal in a cluster, you will need to copy this Keystore file to
all nodes in the cluster.

Set Application Server Startup JVM Options

Add the following JVM options to the application server startup:

Mandatory JVM Option

(For all Application Servers)

-Dsigma.persistance.xml.location=<path to persistence xml> Sample sigma persistence files
are included with CA ldentity
Example Values: Portal in the CA Identity Portal

file:d:\SIGMA\3rd-party-config-files\tomcat-persistence-files\sigma-persistence.xml|
file:d:\SIGMA\ 3rd-party-config-files\tomcat-persistence-files\sigma-persistence-
oracle.xml party-config-files" folder.

Sample files are provided for
all application server types
and database types.

home folder under the "3rd-

For Oracle DB, use the "sigma-
persistence-oracle.xml" file. For
MySQL and MS SQL use the
"sigma-persistence.xml" file.

-Dhibernate.id.new_generator_mappings=true Set only in case Oracle is used
as a Database for CA Identity
Portal.

-Dsigma.spring.jpa.context=file:d:\SIGMA\3rd-party-config- Sample sigma jpa context files

files\tomcat-persistence-files\sigma-jpa-context.xml are included with CA Identity

Portal in the CA Identity Portal
home folder under the "3rd-
party-config-files" folder.
Sample files are provided for
all application server types.
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Mandatory JVM Option

(For all Application Servers)

Manual Installation

Cluster Related

-Djgroups.mping.mcast_addr=228.6.7.9
-Djgroups.mping.mcast_port=46656
-Djgroups.bind_addr=<server ipv4 address>

Needed for CA Identity Portal
cluster communications. See
Cluster Requirements section
for more information.
Substitute your server IP
address. Each CA Identity
Portal node is a cluster must
be set with its own IP address.

Dsigma.infinispan.configuration.location=file:D:\SIGMA\conf\infinispan
-config.xml

Path to the CA Identity Portal
caching properties file.

Use this if you want to
override the default caching
properties. Sample infinispan
config files are included with
CA Identity Portal in the CA
Identity Portal home folder
under the "3rd-party-config-
files" folder.

Sample files are provided for
all application server types.

Log Related

-Dlog4j.configuration=file:D:\SIGMA\conf\log4j.properties

Path to the CA Identity Portal
log properties file.

Use this if you want to
override the default log
properties. A sample
logdj.properties file is
provided in the CA Identity
Portal home folder in "sigma-
docs\log4j.properties.sample"
. The file system path is an
example.

-Dlogdj.logpath=<path to log directory>
-Dorg.apache.cxf.Logger=org.apache.cxf.common.logging.LogdjLogger

Designate an operating
system path (for example:
d:\sigma\logs) to store CA
Identity Portal related logs.

Memory Related
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Mandatory JVM Option

(For all Application Servers)

-XX:MaxPermSize=512m Needed for runtime
compilation of TEWS classes.

-Xms4g Minimum and Maximum JVM

-Xmx8g Heap Memory limits. These
values should reflect the
expected load and available
RAM on the CA Identity Portal
server. The example given is
for a production serverin a
large enterprise organization
with 32GB of RAM. Memory
benchmarks should always be
performed and memory
prams fine-tuned on regular
basis (for example, using
JConsole).

Encryption Related (CA Identity Portal Keystore)

-Dsigma.encryption.keystoreLocation=D:\SIGMA\conf\sigma.keystore Sets the file system path and
-Dsigma.encryption.keystorePassword=<secret_password> passwords for the CA Identity
-Dsigma.encryption.keyPassword=<secret_key_password> Portal Keystore. The keystore

-Dsigma.encryption.keyName=<key_name> file must already exist (See

"Generating a CA Identity
Portal Keystore file" in this
guide).

JVM Option
(for Apache Tomcat Only)
-Dbtm.root=<Tomcat Home Path> Set when Bitronix is used with
-Dbitronix.tm.configuration=<Tomcat Home Path>\conf\btm- Tomcat.
config.properties Note: make sure you use short

names on the Apache Tomcat
Home Path (for example, use
"Progra~1" instead of "Program
Files")
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@ Note: How to set JVM options in different Application Server
Oracle Weblogic
- If you are using an Oracle WeblLogic Node Manager to start the nodes, use the Oracle WebLogic
Administration Console to add the above JVM options to each node "Server Start" section.
- In case you are not using the Oracle WebLogic Node Manager to start the nodes (you start them
manually from scripts), add the above JVM options to Domain wide setDomainEnv.cmd/ setDomainEnv.sh
startup script.
Apache Tomcat
On MS Windows, use the "Configure Tomcat" utility (Tomcat7w.exe). Update the startup script (for Linux
based deployments), to add these JVM options.
Red Hat JBoss
Set the JVM options in the batch file you use to start Red Hat JBoss (for example: standalone.bat or
standalone.sh). Alternatively, you can use the Red Hat JBoss Admin Console.

Configure a Data Source in the Application Server

This step is relevant only for Oracle WebLogic and (RH) JBoss (for Apache Tomcat, skip to the next step
"INSTALLING BITRONIX (JTA) ON TOMCAT").

Configure a database XA Data Source in the Application server to connect to the CA Identity Portal
database. Make sure to select the correct Database type/driver.

For WeblLogic, set the following Data source JNDI Name: jdbc/sigmadb
For JBoss, set the following Data source JNDI Name: java:jboss/datasources/jdbc/sigmadb

Example 1: WebLogic using a MySQL Database

Configuration  Targets  Momionng  Conirol | Sequnity | Pates

General  Connection Pool  Orade | ONS | Transacton Disgnostics  Idenbity Options [;}

Sae

Apphcatons get a database connection from a data source by looking up the: data source on the: Java Naming and Directory Interface [MDT) tree and then reguesting a
connecBon., The data source provides the connecbon o the spplication from s pool of datsbecs connechons.

Thes page enahiss you b define general configurabion opbions for this J1DBC data source.

Name: Ds A LM name that e 14 ]
ML Mere Infa...
-[__*,. INDT Name: The MO path to where this dat ound -3 =
MO ris i the e of the: d Mors Info
jdes/ sdgmadh
) Row Prefetch Enabled Emables multiphe rows to be “prefetched” (that is; sent from the server
to the dient) in one server scoess.  More Info...
&) Row Prefetch Sire 48
More Infio,
T-' Stream Chunk Size; acR Specifies the dats dhunk sire for stesming dats types,  More Info...

Save
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Configuration | Targets Monitoring Control | Security | Motes

General Connection Pool | Transaction Diagnostics Identity Options

Save
The connection pool within a JDBC data source contains a group of IDBC connections that applications res
connections within it are created when the connection pool is registered, usually when starting up WeblLog

Use this page to define the configuration for this data source's connection pool.

af] uRL: jdbc-mysql-//10.0.0.70-3306/sigmacc

‘-@ Driver Class Name: com.mysgl_jdbe . Driver

AE] Properties:
user=sigma

5

System Properties:

Example 2: (RH) JBoss and an Oracle database:

Use the JBoss admin console to configure a new XA Data Source for CA Identity Portal.

=]

JBOSS ENTERPRISE
APPLICATION PLATFORM 6.1.0.GA Profile Runtime

= Subsystems

Datasources XA Datasources

Connector

JDBC XA Datasources

Jca JDBC XA datasource configuration.

Datasources

Available XA Datasources
Resource Adapters

Mail Add Remove Disable
Container Name INDI Enabled?
Core * sigma-ds Jjava:jboss /datasources/jdbc/sigmadb ¥
Security 1-1of 1
Web Selection
B General Configuration Aftributes  Connection Security Properties Pool Validation
Interfaces Eait
Socket Binding
Paths Name: sigma-ds JNDI: java:jboss /datasources/jdbc/sigmadb
System Properties
XA Data Source Class: Is enabled?: true
Driver: oracle Share Prepared Statements: false

Statement Cache Size: 0
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Example 3: (RH) JBoss and a MSSQL database:

Use the JBoss admin console to configure a new XA Data Source for CA Identity Portal.

JBOSS' ENTERPRISE

APPLICATION PLATFORM 6.1.0.GA Profile Runtime

= Subsystems

Datasources XA Datasources

Bl Cannectar JDBC XA Datasources

JDBC A datasource configuration.

Available XA Datasources

Resource Adapters

Add Remove Dizable
Mail
MName HDI Enabled?
Container
Core * SIGMA Java:jboss/datasources/ jdbc/sigmadb v
1-10of 1
Security
ek Selection
Aftributes Connection Security Properties Paol Validation
= General Configuration
Edit
Interfaces
Socket Binding
java:jboss/datasources
Name: 5|GM& INDI:
Faths ame /jdbe sigmadhb
System Properties S
XA Data Source Chlass: com.microsoft.sglserver, jdbo.SQLServer? Is enabled?: true

Driver: sqlserver Share Prepared Statements: false

Statement Cache Size: 0

Make sure to set these three properties on the datasource: DatabaseName, SelectMethod,
ServerName

JBOSS' ENTERPRISE
APPLICATION PLATFORM 6.1.0.GA Profile Runtime

= Subsystems

Datasources XA Datasources
B Connectar JDBC XA Datasources
1ch JDBC ¥4 datasource configuration.
Available XA Datasources
Resource Adapters
Add Remove Disable
Mail
Mame JHDI Enabledy
Container
Core * SICMA java:jboss/datasourcesfjdbc/sigmadb ¥
1-1of 1
Security
Web Selection
Attributes Connection Security Properies Pool Validation
= General Configuration
Add
Interfaces
Socket Binding
A Key Value Qption
Paths
. DatabaseMame sigma Fernove
System Properties
SelectMethod cursor Rernowe b
ServerMNarne localhost Rernowe

1-30f 3
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Installing BITRONIX (JTA) on Apache Tomcat Only

Apache Tomcat application server does not supply JTA transaction Manager functionality that are

necessary for CA ldentity Portal. On Apache Tomcat you must use Bitronix (BTM), which is an open-
source JTA transaction Manager. CA Identity Portal supports the Bitronix version 2.1.3.

1) Download the BTM distribution from:

http://bitronix.be/downloads/btm-dist-2.1.3.zip

2) Unzip the BTM distribution and copy to following jars to your Apache Tomcat lib folder.

i. <BTM Distro Root>\lib\slf4j-api-1.6.4.jar

ii. <BTM Distro Root>\lib\sIf4j-jdk14-1.6.4.jar

iii. <BTM Distro Root>\lib\geronimo-jta_1.1_spec-1.1.1.jar

iv. <BTM Distro Root>\integration\btm-tomcat55-lifecycle-2.1.3.jar

v. <BTM Distro Root>\btm-2.1.3.jar

Create a file in the Apache Tomcat configuration folder called "resources.properties" with the

following configuration (this is an example for a MySQL database configuration). A sample file
is included in the CA Identity Portal Home Folder under "\SIGMA\3rd-party-config-
files\bitronix\resources.properties".

resource.

resource.

resource.

resource.

resource

resource

resource

resource.

resource.

ds.

ds.

ds.

ds.

.ds.

.ds.

.ds.

ds.

ds.

className=com.mysqgl.jdbc.jdbc2.optional.MysglXADataSource
uniqueName=jdbc/sigmadb

minPoolSize=10

maxPoolSize=10
driverProperties.URL=jdbc:mysqgl://10.0.0.70/sigmadb
driverProperties.user=sigma
driverProperties.password=xxXxXx
allowLocalTransactions=true

driverProperties.pinGlobalTxToPhysicalConnection=true

@ Note: Substitute the database type and connectivity information in the above example with

parameters relevant to your database.

Create a file in tomcat configuration folder called "btm-config.properties" with the

following configuration:

bitronix.

bitronix.

bitronix.

bitronix.

tm.

tm.

tm.

tm.

serverId=tomcat-btm-node0
journal.disk.logPartlFilename=${btm.root}/work/btml.tlog
journal.disk.logPart2Filename=${btm.root}/work/btm2.tlog

resource.configuration=${btm.root}/conf/resources.properties

Edit "server.xml" file in Apache Tomcat conf directory, under the line:

<Listener className="org.apache.catalina.mbeans.GlobalResourcesLifecycleListener"/>

Add this line:

<Listener className="bitronix.tm.integration.tomcat55.BTMLifecycleListener"/>


http://bitronix.be/downloads/btm-dist-2.1.3.zip
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Edit "Context.xml" file in Apache Tomcat conf directory, under the line:

<WatchedResource>WEB-INF/web.xml</WatchedResource>

Add this line:

<Transaction factory="bitronix.tm.BitronixUserTransactionObjectFactory" />
<Resource name="jdbc/sigmadb" auth="Container" type="javax.sql.DataSource"
factory="bitronix.tm.resource.ResourceObjectFactory" uniqueName="jdbc/sigmadb"/>
<Resource name="TransactionSynchronizationRegistry" auth="Container"
type="javax.transaction.TransactionSynchronizationRegistry"
factory="bitronix.tm.BitronixTransactionSynchronizationRegistryObjectFactory"/>

Deploy the CA Identity Portal Application Web Archive to the Application
Server

Locate the CA Identity Portal web archive file "sigma.war" in the CA Identity Portal Home Folder.

Deploy the CA Identity Portal web archive to your application server.

For Apache Tomcat

1) Stop the application server.
2) Copy the sigma war file to the tomcat "webapps" folder (<tomcat home\webapps):

For example:
C:\tomcat7\webapps\

For Oracle WeblLogic

Use the Oracle WebLogic Administration Console to deploy the sigma war as a web application.

In case you have an Oracle WebLlogic cluster, make sure to deploy the application to the Cluster.

For Red Hat JBoss

Use the JBoss Admin Console to deploy the CA Identity Portal Application Web Archive to the server
runtime.
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(1) Messages

JBOSS' ENTERPRISE,
APPLICATION PLATFORM 6.1.0.GA Profile  Runtime

= Server Deployments

Overview

Deployments

Currently deployed application components.

B Status
Available Deployments

= Platform Add Remove En/Disable Replace
JvM * sigma.war L4 web I}
Enviranment

= Subsystems
Datasources
JNDI View

Transactions
Transaction Logs
Web

Webservices
Deployment

Name: sigma.war

Runtime Name: sigma.war

Create a User to Access the CA Identity Portal Administration UI

Create an application server user and group for accessing the CA Identity Portal Administration UL.

To access the CA Identity Portal Admin Ul you need to create the appropriate security group and users
in the application server.

For Apache Tomcat

Add the following to "tomcat-users.xml"

<role rolename="SigmaAdministrators"/>

<user username="sigma" password="secretl23" roles="SigmaAdministrators"/>

For Oracle WeblLogic

1) Using the Oracle Weblogic Admin Console, create an Oracle Weblogic security group called
"SigmaAdmins".
2) Create a user called "sigma" or any other user and place that user in the "SigmaAdmins" group.
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Manual Installation

Change Center
View changes and restarts
Configuration editing is enabled, Fubure

changes will automaticaly be activated as you
modify, add or delete items in this domain,

Domain Structure

1DMDey Dimain

Welcome, weblagic | Connectzd to: IDMDevDomain

8 Home Log Out Preferences [ Record Help

Q

Home =myrealm =Users and Groups =sigma =Users and Groups sweblogic sSummary of Security Realms smyrealm =Users and Groups =Sigmaddmins =Users and Groups
Settings for myrealm

Configuration | Users and Groups | Roles and Policies | CredentialMappings | Providers | Migration

Users | Groups

This page dlsplays{kfurmatmn about each group that has been configured in this security realm,

§ Customize this table

Failed (0)
[ critial (D)

Frusdeaded (01

Diagrostics Groups
New | | Delete Showing 1 to 90f 9 Previous | Next
[]| Name & Provider
[T | adminChannelusers adminChannelLisers can access the admin channel. Defaultauthenticator
[] | Administratars Adrrinistrators can view and modify all resource attributes and start and stop servers, DefaultAuthenticatar
How do I... =] [ | appTesters AppTesters group, Defaultauthenticator
o Manage users and groups [ | crossDomainConnectors | CrossDamainConnectors can make inker-damain calls from foreign domains. DefaultAuthenticatar
o Creste groups [ | Deplayers Deployers can view all resource sttributes and deploy appiications. DefaultAuthenticator
+ Modiy groups [] | Manitars Monitars can view and modify al resource attributes and perform operations nat restricted by rales. Defaultauthenticator
« Delet:
wiete droups [7] | operators Operatars can view and modiFy all resourcs attributes and perform ssrver IFecycls operations. DefaultAuthenticator
[] | Oradesystemroun Orade application software system grodp. DefaultAuthenticatar
System Status =]
Sigmaidrrins Sigma Administratnr:‘) DefaultAuthenticator
Health of Running Servers
New | | Deete Showing 1 to 3.of 9 Previous | Next

Change Center
view changes and restarts
Corfiguration editing is enabled. Future

changes will automatically be activated as you
modfy, add or delete items in this domain.

Domain Structure

IDMDevDomain

Howdo L.

» Manage users and groups
= Create users

o Modfy usars

Connecked ko IDMDevDomain

ecord Help Welcome, weblogil

Q

@) Home Log Out Preferences
Herme smyresim =Users snd Groups =sigms sUsers and Groups sweblogic sSummary of Security Realms =myreaim Users and Groups Sigmaddming >Users and Groups
Settings for myrealm

Configuration | Users and Groups | Roles and Policies | Credential Mappings | Providers | Migration

Users | Groups

This page displays information about sach ser that has been configured in this security resim.

| Customize this table

Users
[New | |Delete Showing 1 to 3 of 3 Previous | Next
]| Name & Description Provider
[T | oradesystemiser Oracle spplication software system user, DefaultAuthenticator
sigma Sigma Administrator DefaultAuthenticator
[ | weblogic This user is ths defaul administrator. DefaulbAdthenticator
\New | |Delete Showing 1 to 3 of 3 Previous | Next

Change Center
view changes and restarts
Configuration editing is enabled. Future

changes will automatically be activated as you
modfy, add or delets items in this domain,

Domain Structure
10MDevDomain
nwironment:
eployments
ervices

How do 1.

9

Record Help Welcome, weblogic | Connected to: IDMDevDomai

Q

@) Home Log Out Preferences
Herme =Lisers and Groups ssigma >Users and Groups sweblagic sSummary of Security Resims smyreslm =Users and Groups Sigmatdming »Users and Groups »sigmia

Settings for sigma

Passwords | Attributes

General Groups

Save
Use this pags to configurs group membership for this user.

This user can be 2 member of any of these parent graups.  Mare Infa...

Parent Groups:
Availabl
[[] AdminChannelUsers =~
[C] Administrators B
[T] AppTesters
[T] CrossDomainConnectors| =
[ Deployers
[C] Monitors
[] Operators
[~ OracleSvstemGroun

Chosen:
[7] sigmaAdmins
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For (RH) JBoss

Use the JBoss add_user.bat/add_user.sh script supplied with JBoss (under the <JBoss_Home>/bin

folder). Follow these guidelines (sample run of the add_user utility):

What type of user do you wish to add?

a) Management User (mgmt-users.properties)

b) Application User (application-users.properties)
(a): b
Enter the details of the new user to add.

Realm (ApplicationRealm)

Username : sigma
Password : XXXXXXX
Re-enter Password : XXXXXXX

What roles do you want this user to belong to? (Please enter a comma separated
list, or leave blank for none)|[ ]: SigmaAdministrators

About to add user 'sigma' for realm 'ApplicationRealm'
Is this correct yes/no? yes

Added user 'sigma' to file 'C:\jboss-eap-
6.1\standalone\configuration\application-users.properties’

Added user 'sigma' to file 'C:\jboss-eap-6.l\domain\configuration\application-
users.properties'

Added user 'sigma' with roles testers to file 'C:\jboss-eap-
6.1\standalone\configuration\application-roles.properties’

Added user 'sigma' with roles testers to file 'C:\jboss-eap-
6.1\domain\configuration\application-roles.properties'

Is this new user going to be used for one AS process to connect to another AS
process?

e.g. for a slave host controller connecting to the master or for a Remoting
connection for server to server EJB calls.

yes/no? yes

Validate Installation Results

Start the application server.

Review CA ldentity Portal log file for startup errors (CA Identity Portal logs are written to the
application server stdout and stderr logs).

Check the CA Identity Portal Administration Ul is up.

Browse to: http://<application server host>:port/sigma/admin
For example: http://localhost:8080/sigma/admin

b) Provide the User ID and Password you defined for the CA Identity Portal Administrator.

[E] Note: In case the userid and password for the Admin Ul fail, reset the password for that application server

user using the application server native tools.

4)

Go to the Post Installation section in this document.
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Installing CA Identity Portal in a Cluster

CA Identity Portal can be deployed in a cluster. A CA Identity Portal cluster is essentially a collection of
two or more application server nodes running the CA Identity Portal application and sharing a
common CA Identity Portal store (database).

To deploy CA Identity Portal in a cluster, follow the installation steps outlined in either Installing Using
the CA Identity Portal Installer or Manual Installation. To create the CA Identity Portal cluster, simply
repeat the procedure on each application server node in the cluster.

After you complete the installation on all cluster nodes, follow these special Cluster Post Install steps:

Copy the CA Identity Portal Keystore File from the 15 Node to All the Other
Server Nodes

CA Identity Portal uses a symmetric encryption key to encrypt sensitive values in the configuration
store. The encryption key is generated by the CA Identity Portal installer, or manually during the
installation of CA Identity Portal. All nodes in the CA Identity Portal cluster must use the same key.
Follow the following procedure to ensure all nodes use the same key.

1) Locate the sigma keystore file "sigma.keystore" on the first node on which you installed sigma.

This is usually located under: "<SIGMA_HOME>\SIGMA\sigma-keystore-tool\sigma.keystore".
2) Copy that file to all the other nodes, overwriting the files on those nodes (in that same location).
3) Restart the nodes.
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Post Installation

CA Identity Manager Environment Validation

Use the IM Management Console and make sure you can export the IM Environment Role and Task
Settings. Save this export as a backup of the environment before proceeding to the next step.

Import CA Identity Portal Roles and Tasks into CA Identity
Manager Environment

1. Locate the SIGMA-CORE-RoleDefinitions.xml file in the CA Identity Portal Home Folder (for
example: C:\SIGMA\sigma-docs\SIGMA-CORE-RoleDefinitions.xml).

Connect to the CA Identity Manager Management Console.

Select the IME you want to integrate with CA Identity Portal.

Click Roles and Task Settings.

Click Import, Browse and select the SIGMA-CORE-RoleDefinitions.xml.

Restart the environment.

ok wnN

@ If the IDM environment you plan to integrate CA Identity Portal with does not have Provisioning
configured (a provisioning directory is not configured for the environment), modify some of the CA
identity Portal service tasks that you imported with the CA identity Portal Role Definitions XML.
Follow the instructions in Appendix D — CA Identity Portal & IDM without Provisioning.

Task Configuration in CA Identity Manager Environment

1. Using the CA Identity Manager Management Console under "Environment Advanced Settings -
Web Services", Enable Execution for "Web Services". Restart the environment.
See "Appendix B" in this document for a screen shot of how TEWS should be configured.

2. Using the User Console, modify the "View My Work List" admin task and enable it for web
services in the task profile definition screen.

Copy Workpoint Client JARS (from CA Identity Manager
Application Server to CA Identity Portal)

Copy the following Jars from the CA Identity Manager Workpoint lib directory to a local directory
on the CA Identity Portal application server (in case of a CA Identity Portal cluster, copy these jars
to all the CA Identity Portal cluster nodes). This local folder directory will be referenced once,
configuring a CA Identity Manager connector in the CA Identity Portal administration Ul:
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For CA Identity Manager on (RH) JBoss Server

10.

11.

12.

13.

<JBoss IAM.im Deployment Folder>\library\wpClient.jar
<JBoss IAM.im Deployment Folder>\library\wpCommon.jar
<CA identity base installation dir>\IAM Suite\ldentity
Manager\tools\workpoint\lib\jbossall-client.jar

<CA identity base installation dir>\IAM Suite\ldentity
Manager\tools\workpoint\lib\Jboss\jboss-client.jar

<CA identity base installation dir>\IAM Suite\ldentity
Manager\tools\workpoint\lib\JBoss\jboss-common-core.jar <CA identity base installation
dir>\IAM Suite\ldentity Manager\tools\workpoint\lib\JBoss\jboss-integration.jar
<CA identity base installation dir>\IAM Suite\ldentity
Manager\tools\workpoint\lib\JBoss\jboss-javaee.jar

<CA identity base installation dir>\IAM Suite\Identity
Manager\tools\workpoint\lib\JBoss\jboss-logging-spi.jar
<CA identity base installation dir>\IAM Suite\Identity
Manager\tools\workpoint\lib\JBoss\jboss-remoting.jar
<CA identity base installation dir>\IAM Suite\ldentity
Manager\tools\workpoint\lib\JBoss\jboss-security-spi.jar
<CA identity base installation dir>\IAM Suite\Identity
Manager\tools\workpoint\lib\JBoss\jboss-serialization.jar
<CA identity base installation dir>\IAM Suite\Identity
Manager\tools\workpoint\lib\JBoss\jbosssx-client.jar

<CA identity base installation dir>\IAM Suite\ldentity
Manager\tools\workpoint\lib\JBoss\jnp-client.jar

<CA identity base installation dir>\IAM Suite\Identity
Manager\tools\workpoint\lib\JBoss\policy.jar

For CA Identity Manader on Oracle WebLogic Server

1.

<Oracle WeblLogic Server Home>\lib\wlclient.jar

For example: D:\Oracle\wlserver\server\lib\

<WebLogic iam_im.ear Deployment Folder>\APP-INF\lib\wpClient.jar
<Weblogic iam_im.ear Deployment Folder>\APP-INF\lib\wpCommon.jar

For example: D:\Oracle\wlserver\server\lib\
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For CA Identity Manadger on IBM WebSphere Server
1. <WAS_SERVER_HOME>\runtimes\com.ibm.ws.ejb.thinclient_7.0.0.jar
2. <WAS_SERVER_HOME>\runtimes\com.ibm.ws.orb_7.0.0.jar

3. From the <WAS_SERVER_HOME>\WebSphere-ear\ldentity Manager\WAS_IMr12.ear
file fetch the following jars:

a. Library\wpCommon.jar

b. Library\wpClient.jar

Set Endorsed Libraries Override (JBoss Only)

If you are using (RH) JBoss, you need to configure an override for the Java Endorsed Directory, before
you start the CA Identity Portal application server. Follow the procedure below:

Extract CA Identity Portal Specific JAR Files from the CA Identity Portal Web
Archive

Locate the CA Identity Portal web archive "sigma.war". It should be present in the CA Identity Portal
home folder.

For example: C:\SIGMAQA\SIGMA\sigma.war

From the folder where the "sigma.war" is located Run the following commands to extract the CA
Identity Portal specific JAR files:

"JAVA HOME/bin/jar" xf sigma.war WEB-INF/lib/jaxb-api-2.2.6.jar
"JAVA HOME/bin/jar" xf sigma.war WEB-INF/lib/geronimo-jaxws 2.2 spec-1.1.jar
For example (on windows):

"C:\Java\jdkl.6.0 45\bin\jar" xf sigma.war WEB-INF/lib/jaxb-api-2.2.6.jar

"C:\Java\jdkl.6.0 45\bin\jar" xf sigma.war WEB-INF/lib/geronimo-jaxws 2.2 spec-1.1.jar

These commands will extract the required JAR files to the following folder under the CA Identity Portal
home folder:

<SIGMA_HOME>\SIGMA\WEB-INF\lib\geronimo-jaxws_2.2_spec-1.1.jar
<SIGMA_HOME>\SIGMA\WEB-INF\lib\jaxb-api-2.2.6.jar

Copy CA Identity Portal Specific JARS to the JDK Endorsed Directory
1. Create an Endorsed Lib folder under your JDK lib folder:

For example:
Locate your JDK Lib folder:
c:\Program Files\Java\jdk1.6.0_45\jre\lib\
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Create a folder named "endorsed" under the \lib\ folder:
c:\Program Files\Java\jdk1.6.0_45\jre\lib\endorsed\

2. Copy the two JARs you extracted in the previous step to the JDK endorsed folder. After you
complete this step, the JDK endorsed folder should have the following content:
c:\Program Files\Java\jdk1.6.0_45\jre\lib\endorsed\geronimo-jaxws_2.2_spec-1.1.jar
c:\Program Files\Java\jdk1.6.0_45\jre\lib\endorsed\jaxb-api-2.2.6.jar
3. Verify that (RH) JBoss uses the JDK endorsed directory.
Look for the following line in the (RH) JBoss log file (the path should point to your JDK
endorsed directory):

java.endorsed.dirs = c:\Program Files\Java\jdkl.6.0 45\jre\lib\endorsed
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CA Identity Portal and Single-Sign-On
(SSO)

Supported SSO Products

CA Identity Portal currently supports SSO with CA Single Sign On. See "Supported Single-Sign-On
Options" in this document, for specific CA Single Sign On versions.

Background

When CA Identity Portal is used by an end user, all actions performed on the user's behalf in CA
Identity Manager (via TEWS) need to run in the user's security context in CA Identity Manager. In case
CA Identity Portal is not protected by a web SSO solution (like CA Single Sign On), the end user
supplies a user ID and password to CA Identity Portal. CA Identity Portal, in turn, supplies these
credentials to TEWS?, thus running the CA Identity Manager tasks in the user context.

In case CA Identity Portal is protected by a web SSO solution, such as CA Single Sign On, the end user's
password is unknown to CA Identity Portal. All that is knows to CA Identity Portal is the user ID and
hopefully the user's DN in the CA Identity Manager User directory. CA Identity Portal, without the
user's password, now needs to invoke actions in CA Identity Manager on behalf of this user.

Several SSO scenarios can exist in a customer's environment, but in order for CA Identity Portal to
support SSO the TEWS security framework MUST be configured for CA Single Sign On authentication,
and without "Admin Password required" (see Option 1 in Table 1 below). In addition, CA Identity
Portal must pass the appropriate CA Single Sign On HTTP headers with the TEWS SOAP call in order for
TEWS to accept the user context.

1 In this case the TEWS Security properties need to be set to: "Enable admin_id (allow impersonation)" and
"Admin Password is required" (See Screenshot 2 in Appendix B).
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Background

The following table lists the most common combinations of initial conditions (before CA Identity Portal

deployment) and the effects of CA Identity Portal's Single Sign On deployment for existing TEWS

clients.

Table 1

CA Identity Portal/CA Identity Manager Single Sign On (S50) Options (Before CA Identity Portal

deployment)
Option CA TEWS CA Notes
Identity Identity
Manager Portal
1 SSO SSO Protected (No SSO This is the most desired/least complex initial
Protected Admin_password) Protected conditions for a CA Identity Portal SSO
deployment. Here the customer's TEWS setup
is already configured for CA Identity Portal SSO
support.
2 SSO Not used at all SSO This is next desired/least complex initial
Protected Protected conditions for a CA Identity Portal SSO
deployment. Here TEWS is not used by anyone
or any process (i.e. bulk load) and its
configuration for CA Identity Portal will not
affect other processes.
3 SSO Admin_Id & SSO In this case, existing customer TEWS clients
Protected Password Protected Protected (like the bulk loader client) will need to migrate
from using Admin_ID and password to using
SSO authentication. Either this or CA Identity
Portal will not be SSO protected.
4 No SSO Admin_Id & SSO In this case, existing customer TEWS clients
Password Protected Protected (like the bulk loader client) will need to migrate
from using Admin_ID and password to using
SSO authentication. Either this or CA Identity
Portal will not be SSO protected.
5 SSO SSO Protected SSO The TEWS setup of the customer must be set
Protected (Admin_password is Protected  to not use the Admin_password while using CA

also used)

Single Sign On. This may affect existing TEWS
clients. If this is not set CA Identity Portal
cannot use SSO.
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SSO Prerequisites

Enable Support for HTTP "delete" verb in CA Single Sign On

Out of the box, a CA Single Sign On deployment is not configured to allow the HTTP DELETE verb. CA
Identity Portal requires that CA Single Sign On allows the DELETE verb for the CA Single Sign On Realm

protecting CA Identity Portal. Follow this procedure to enable the DELETE verb.

1) Create a Delete Action for the CA Single Sign On Web Agent.
By default, the WebAgent has only the Get, Post, and Put Actions available.
To add the Delete Action, complete the following steps:

a)
b)
c)
d)
e)

f)

In the CA Single Sign On Administration Console, click View and select Agent Types.
Select Agent Types in the Systems pane.

Double-click Web Agent in the Agent Type list.

In the Agent Type Properties dialog box, click Create.

Enter Delete in the New Agent Action dialog box and click OK.

Click OK again to save the new Action.

= Agents » Authentication » Directory » Hosts

Infrastructure | Policies ] Reports l Administration ]

Modify Agent Type: Web Agent

«Name: \Web Agent

Agent Type Definition

RADIUS Device
IETF Vendor ID 2552

Action

Delete

Get
ImpersonateStart
ImpersonateStartlsel
OnAccessAccept
OnAccessReject
OnAuthAccept
OnAuthAttempt
OnauthChallenge
OnAuthReject
OnAuthUserNotFound
Post

ProcessS0OAP
ProcessxML

Put

Create

SSO Prerequisites
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2) Inthe Rule configured to protect the CA Identity Portal realm make sure to select the
Delete, Get, Post, Put verbs in the Agent Actions section:

Modify Realm: SIGMA Application

*Name: [SIGMA Application |
Domain: SIGMA APP Domain

Resource

=Agent [im_sigma =]
Resource Filter |/sigma/ |

Effective Resource im_sigma,/sigma/
Default Resource Protection @& Protected 0 Unprotected

Authentication Scheme | SIGMA Form Authentication v

Name Description ‘
SIGMA Allow all resources

Create)

Infrastructure I Policies | Reports I Administration
» Applications = Domains *» Expressions * Global » Password

Modify Rule: SIGMA Allow all resources
Modify Realm: SIGMA Apolication » Modify Rule: SIGMA Allow all resources

«Mame: SIGMA Allow all resources |

Domain: SIGMA APP Domain

Realm and Resource

Resource *
Effective Resource: im_sigma/sigma/™
Regular Expression [

Allow /Deny and Enable/Disable

® Allow Access
) Deny Access
Enabled ¥

Action

® Web Agent actions

) Authentication events
) Authorization events
o Impersonation events

«Action
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CA Identity Portal Realm Protection
Protect CA Identity Portal in CA Single Sign On as you would any other web application.

The CA Identity Portal URI to protect is "/sigma/".

However, CA Single Sign On needs to authenticate users for CA Identity Portal using the same
authentication directory used to protect the CA Identity Manager realm (for the environment CA
Identity Portal is integrating with).

For example, in case CA Single Sign On protects the CA Identity Manager realm with AD SSO and
authorization directory mapping between AD and the IDM user store, protect the CA Identity Portal
realm in exactly the same manner (using the same authentication directory and authorization

mapping).

Required CA Single Sign On Headers

CA Identity Portal relies on the out of the box CA Single Sign On authentication and authorization HTTP
headers. In case your CA Single Sign On deployment was modified from its OOTB configuration, make
sure the CA Identity Portal realm is configured to forward these specific SSO headers:

e sm_user

e sm_userdn

e sm-authtype

e sm_serversessionspec

IIS Error Page Handling

In case the CA Single Sign On agent protecting CA Identity Portal is installed on Microsoft Internet
Information Services (IIS), you need to enable "Detailed errors" in the 1IS "Error Pages" settings.

The following instructions are for IIS v.7.5:

1. Select the Site protecting CA Identity Portal.

2. Open the "Error Pages" Feature.

3. Click on "Edit Feature Settings".

4. Select the "Detailed error" option and click OK.
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0 Error Pages

|Jse this feature to configure HTTP error responses. The error responses can be custom errar
pages, ot detailed error messages that contain troubleshooting information,

Edit Error Pages Settings 7| x|

—Errar Responses
‘When the server encounters an error, reburn:
" Cuskom error pages
% Detailed errors

Detailed erraors for local requests and custom error pages
for remote requests

—Default Page
Path:

| ]

Path tvpe:

[File =l

o4 I Zancel

@ This feature configures 115
error pages, To learn more
about how ko configure cuskom
ASP.MNET etrar pages, click
here,

Add. ..

Edit Feature Settings. ..

'@' Help

Cinline Help
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TEWS Security Settings

When CA Identity Portal is protected by CA Single Sign On, set exactly the following properties for
TEWS in the CA Identity Manager environment serving CA Identity Portal (Either "Basic" or "Other" can
be selected?).

TEWS settings for CA Identity Portal with SSO

Horme » Environments » Sigra » Advanced Settings » Web Services

Weh Services Properties

Property

Enable Execution v

Enable ¥WSDL Generation Ird

Enable admin_id (allow impersaonation) v

Admin password is required r %_

SiteMinder Authentication  (Nane)
@ Basic Authentication
© Other

WSS Username Token (Fassword Text) Il

Generate W3DOL in WS-l farm (Note:

your existing TEWS code may need to r

be maodified).

@ CA Identity Portal does not support "TEWS configured with WSS Username Token" and "WS-1 WSDL
Format".

CA Identity Governance, CA Identity Portal, and SSO

CA Identity Governance Web Services do not implement support for CA Single Sign On authentication
(as of 12.5 SP7). CA Identity Governance Web services security implementation checks the WSS
security header (UserNameToken) and authenticates (either to AD/LDAP or the Eurekify
configuration). In order for Sigma to support CA Single Sign On with GM as an endpoint the following
configuration is required for the CA Identity Governance Portal:

1) AD/LDAP authentication MUST be disabled in CA Identity Governance.

2) CA Single Sign On authentication needs to be enabled in CA Identity Governance (otherwise users
will be able to access CA Identity Governance with an incorrect password).

2 "Basic" means that CA Identity Manager will automatically configure the realm and protection in the SSO policy
server when the environment is started.
"Other" means, the SSO admin will need to configure the protection of TEWS in SSO.
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Appendix A - Enabling XA Transactions
for MS SQL

If you use a MS SQL database for the CA Identity Portal persistence store, enable XA transactions on
that database server. Follow the procedure below (also see: http://technet.microsoft.com/en-

us/library/aa342335(v=sql.105).aspx for more information).

Configuring XA Transactions for SQL Server 2008 R2

Enable the MS DTS Service on the Windows 0S

The MS DTC service should be marked Automatic in Service Manager to make sure that it is running
when the SQL Server service is started.

On Windows Server 2003:
1: Select Control Panel > Administrative Tools > Component Services.

2: Select Component Services > Computers and right-click My Computer, and select
Properties.

3: Click the MSDTC tab, and then click Security Configuration.
4: Select the Enable XA Transactions check box, and then click OK.
5: Click OK again to close the Properties window, and then close Component Services.
6: Restart SQL Server to ensure that it syncs up with the MS DTC changes.
On Windows Server 2008:
1: Select Control Panel > Administrative Tools > Component Services.

2: Select Component Services > Computers > My Computer > Distributed Transaction
Coordinator.

3: Right-click Local DTC and then select Properties.

4: Click the Security tab on the Local DTC Properties window.

5: Select the Enable XA Transactions check box, and click OK.

6: Click OK again to close the Properties window, and then close Component Services.

7: Restart SQL Server to ensure that it syncs up with the MS DTC changes.


http://technet.microsoft.com/en-us/library/aa342335(v=sql.105).aspx
http://technet.microsoft.com/en-us/library/aa342335(v=sql.105).aspx
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Configure the JDBC Distributed Transaction on the Database Server
In this section you will need files that come with the MS SQL JDBC v4 driver you downloaded before.
1: Locate the following files in the JDBC Driver package:

e sqljdbc_xa.dll
e xa_install.sql
2: Copy the sqljdbc_xa.dll file from the JDBC package to the Binn directory (for a default SQL

Server install, the location is C:/Program Files/Microsoft SQL
Server/MSSQL10_50.MSSQLSERVER/MSSQL/Binn) of SQL Server.

@ Note: If you are using XA transactions with a 32-bit SQL Server, use the sqljdbc_xa.dll file in the x86 folder,
even if the SQL Server is installed on an x64 processor. If you are using XA transactions with a 64-bit SQL
Server on the x64 processor, use the sqljdbc_xa.dll file in the x64 folder.

3: Run the xa_install.sql database script on SQL Server. Run the SQL script as a SQL server
administrator (sa) on the MASTER database.

E] Note: This script installs the extended stored procedures that are called by sqljdbc_xa.dll. These extended
stored procedures implement distributed transaction and XA support for the Microsoft SQL Server JDBC
Driver. You can ignore errors about unable to drop procedures that don't exist.

Grant the CA Identity Portal DB User the XA Role Permission

You need to grant the CA Identity Portal user login to run XA transaction on the database.

1: Open the SQL Server Management Studio to locate the security folder under the master
database.

2: Grant permissions to the CA Identity Portal user to participate in distributed transactions
with the JDBC driver:

Add the user to the SqIIDBCXAUser role in the master database (for example, for a sigmadb user
add master database in User mappings and check SqlJDBCXAUser role).

@ Note: Failure to follow the procedure above to configure XA transactions on the MS SQL server can result
in the following error in the CA Identity Portal server log: "javax.transaction.xa.XAException:
com.microsoft.sqlserver.jdbc.SQLServerException: Failed to create the XA control connection. Error: "Could

rn

not find stored procedure 'master..xp_sqljdbc_xa_init_ex".




Appendix B — TEWS Settings for CA Identity Portal without SSOConfiguring XA Transactions for SQL
Server 2008 R2

Appendix B - TEWS Settings for CA
Identity Portal without SSO

TEWS settings for CA Identity Portal without SSO

Horme * Environments * Sigmma *» Advanced Settings * Web Services

Weh Services Properties

Property

Enable Execution v .

Enable W5DL Generation v -

Enable admin_id (allow impersanation) "

Admin passward is required r

M SiteMindar Authentication & (None)
" Basic Authentication
 Other

WSS Username Token (Fassword Text) r

Generate WSDL in WS- form (Mote:
your existing TEWYS code may need to I
be maodified).
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Appendix C - Configuring JBoss with a
MSSQL Datasource

When using CA ldentity Portal with JBoss and a MSSQL database, select the MySQL database during
the CA Identity Portal installation. After the CA Identity Portal installation is complete, follow the
procedure below to reconfigure JBoss to use a MSSQL XA datasource.

1. Make sure the MSSQL JDBC driver is prepared on the JBoss server. See "Add 3rd Party Jars to the
Application Server" in the "Installation Pre-requisites" section. Follow the instructions for
configuring the MSSQL JDBC driver as a JBoss module.

2. Start the JBoss application server.

Open the JBoss administration console and go to the Profile->Datasources->XA Datasources
Section.

4. Remove the MySQL XA Datasource definition.

5. Create a MSSQL XA datasource:

6. Use the JBoss admin console to configure a new XA Data Source for CA Identity Portal.

Set the JNDI name to: java:jboss/datasources/jdbc/sigmadb

{0) Messages ~

JBOSS ENTERPRISE

APPLICATION PLATFORM 6.1.0.GA Profile Runtime
& Subsysterns Datasources XA Datasources

= Connector JDBC XA Datasources
=3 JDBC XA datasource configuration.

Datasources Awailable XA Datasources

Eesource Adapters -
Add Remove Dizable

N ail

Marme ANDI Enabled?
Container
Core * SIGMA java: jbossfdatasources/jdbc/sigmadb ¥

1-10f 1

Security
Web Selection

Attributes  Connection Securing Properties Fool “alidation

= General Configuration
Edit
Irterfaces

Socket Binding
Java jboss/datasources

Mame: 5|CMA JNDI: -
Paths fjdbcysigmadb
System Properties
XA Data Source Class: com.microsoft.sglserver,jdbc.SQLSenvers Iz enabled?: true
Driver: sglserver Share Prepared Statements: false

Statement Cache Size: 0

£.2 Final-redhat-1 « Tools  #Settings [+ Logout

Make sure to set these three properties on the datasource:
o DatabaseName
e SelectMethod
e ServerName
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JBOSS'  ENTERPRISE

APPLICATION PLATFORM 6.1.0.GA

Profile Runtime

B Subsystems Datasources

XA Datasources

B Connector JDBC XA Datasources
JDBC ¥4 datasource configuration.
Available XA Datasources
Resource Adapters
Add Femove Disable
Mail
MName INDI Enabled?
Container
Core *SICMA java:jboss/datasources/jdbc/sigmadb L4
1-10of 1
Security
Wb Selection
Amributes  Connection 3ecuriy Properties Fool Walidarion
= General Configuration
Add
Interfaces
Socker Binding
A Key “Walue Ciption
Faths
. DatabaseMame sigma Earmove
Systern Properties
SelectMethod cursar Rernove b
ServerMarne localhost Rernowe

1-3a0f 3
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Appendix D - CA Identity Portal & IDM
without Provisioning

In case the IDM environment you plan to integrate CA Identity Portal with does not have Provisioning
configured (a provisioning directory is not configured for the environment), you will need to modify
some of the CA Identity Portal service tasks that you imported with the CA Identity Portal Role
Definitions XML.

1. Modify the "Sigma View User' Admin Task Tabs section and remove the "Provisioning Roles"
and "Provisioning Roles Indirect" tabs.

Modify Admin Task: Sigma - View User

Profile Search Tabs Fields Events Role Use

Which tab controller should be used for this task?

s '_Standard Tab Controller v

Which tabs should appear in this task?

Tab Tag Type
# |profile Profile Profile @@
# |Access Roles AccessRoles Access Roles @ @ @
# | Admin Roles AdminRoles Admin Roles De®
# |Provisioning Roles ProvisioningRoles Provisioning Roles|(=)}4) &)
# |Provisioning Roles Indirect|ProvisioningRolesIndirect |Provisioning Roles @ 1 j_
? Groups Groups Groups = 4 7
# |Delegate Work Items Delegation Delegation GP@®

2. Modify the "SIGMA Admin Scope" Admin Task Profile Screen.
Select: Tabs->Profile->Browse Screen (SigmaAdminScope)->Edit
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Profile Search Fields Events Role Use

Configure Profile
Select Screen Definition

Configure Standard Profile Screen

* = Required

sMName |SigmaAdminScope |

*Tag |SigmaAdminScope | I:\}

Use columns for layout. (=

[JladminTasks| &
[[|provisioningRoles|| 4
[JladminofGroups| &

3. Edit the "|provisioningRoles|" field.
4. Delete the "Initialization Javascript".

Initialization JavaScript

5. Apply and submit the changes.
6. Modify the "SIGMA — TEWS Tasks" Admin Role.
Remove the existing Member Policy.

Modify Admin Role: SIGMA - TEWS Tasks
Profile Tasks Members Administrators owners

Members are able to use the tasks in a role.

Member Policies

Member Rule | Scope Rules

Group

(all)
2| @ Provisioning Rols

(all) ®
User

(all)
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7. Create a new Member Policy with only Groups and User scoping.

Modify Admin Role: SIGMA - TEWS Tasks

Profile Tasks Members Administrators owners

Members are able to use the tasks in a role.

Member Policies

Member Rule | Scope Rules
Group
(all)
#| (all) User @
(all)

8. Submit the changes.
9. Stop and start the CA Identity Portal application server.
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